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About This Manual

Use this Getting Started guide as a resource for using VI Logger, from 
installing software and hardware to executing and analyzing data logging 
data.

Conventions
The following conventions appear in this manual:

[ ] Square brackets enclose optional items—for example, [response].

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names, controls, and buttons on the front panel, dialog boxes, sections of 
dialog boxes, menu names, and palette names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.
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monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

Platform Text in this font denotes a specific platform and indicates that the text 
following it applies only to that platform.

Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• LabVIEW Help, available by selecting Help»VI, Function, and 
How-To Help in LabVIEW

• Measurement & Automation Explorer Help for VI Logger, available by 
selecting Help»Help Topics»VI Logger»VI Logger in MAX

• Measurement & Automation Explorer Help for FieldPoint, available 
by selecting Help»Help Topics»FieldPoint in MAX

• The getting started or user manuals for the devices you use
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1
Using VI Logger

VI Logger equips you with the necessary software tools to define and 
execute a data logging task. With VI Logger, you can view real-time data, 
share data, and browse and manage historical data. Using VI Logger in 
Measurement & Automation Explorer (MAX), and features such as 
triggered acquisition, event detection, and actions and calculated channels, 
you can define advanced tasks without any programming. Using LabVIEW 
and the VI Logger VIs, you can execute a task, view live data, browse 
historical data, and build logging applications using all of the advanced 
programming capabilities of LabVIEW. 

Overview
VI Logger provides dialog boxes to configure data logging tasks. When the 
task runs, acquired data can be displayed in a temporary window with the 
task, and logged data is stored internally. Refer to the following figure for 
an overview of how VI Logger interacts with other software.
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A VI Logger task can run in a stand-alone mode from MAX or as part of 
an application in LabVIEW. A VI Logger task controls data acquisition 
(DAQ) and logging. With VI Logger, you can customize start and stop 
conditions for acquisition. The VI Logger task also logs data for one or 
more channels. After logging data, you can view the data for each time the 
task is run. You can view data from each executed task.

Chapter 2, Creating and Running a VI Logger Task, describes how to 
create a VI Logger task in MAX. Chapter 6, Controlling a Task 
Programmatically Using LabVIEW, describes how to control a logging 
task from LabVIEW.

VI Logger Features
VI Logger helps you log data from National Instruments DAQ devices and 
FieldPoint modules. To set up the logging system, you first set up the 
measurement system. You can configure the logging system with 

• Execute Task
• View Data
• Read Historical Data
• Analyze Data

LabVIEW

• View Data

Remote Computer
Historical

Data

Internet (DataSocket or FTP)

• Configure and Test Board
• Configure and Test Virtual Channel
• Configure and Test FieldPoint Item

MAX

• Define Task
• Execute Task
• Log data
• View Data
• Export to Text, HTML,
  and DIAdem
• Print Graph
• Publish to DataSocket 
  or FTP

VI Logger
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configuration dialog boxes. Refer to Chapter 2, Creating and Running a 
VI Logger Task, for information about the measurement system 
components that you need to configure and instructions to set up and use a 
VI Logger task. 

A VI Logger task requires the following three pieces of information:

• Task name

• NI-DAQ measurement device or FieldPoint module

• One or more virtual channels or FieldPoint channels to acquire and log 
data

To see these three pieces, navigate through the MAX hierarchy. VI Logger 
tasks are listed under the VI Logger Tasks category. NI-DAQ virtual 
channels, FieldPoint items, and FieldPoint modules are organized under 
Data Neighborhood. NI-DAQ devices are stored under Devices and 
Interfaces.

You can further define a task by defining the following additional options:

• Acquisition Settings—In the Task Attributes view, you can select the 
device from which you want to acquire and log data, enter the scan per 
channel rate for each channel, and set the buffer settings. 

• Logging Conditions—In the Task Attributes view, you can set when 
and how the logging begins. You also can configure finite acquisition 
for DAQ channels.

• Web Publishing—Click the Advanced task settings button in the 
Task Attributes view to configure publishing logged data to the Web. 

• Network Publishing—Click the Advanced task settings button to 
publish data to DataSocket, which enables you to access the data 
through a network.

• Acquisition Conditions—In the Task Attributes view, you can define 
the acquisition conditions in which the task will run. The measurement 
task can be started and stopped at a specific time. Also, measurement 
tasks allow a variety of hardware triggering conditions.

• Virtual Channels—In the Virtual Channels view, you can view the list 
of virtual channels you created under Data Neighborhood. You can 
choose to enable logging for each of these channels on this page.

• FieldPoint Channels—In the FieldPoint Channels view, you can view 
the list of FieldPoint items you created under Data Neighborhood. You 
can choose to enable logging for each of these channels on this page.
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• Calculated Channels—If you need to perform some arithmetic 
transformations on the measured data, you can define new channels 
based on acquired channels on the Calculated Channels view. You can 
define linear combinations of two channels, logarithmic or normalized 
logarithmic of acquired channels (dB and dBv), or define a custom 
function of multiple acquired channels.

• Events—Use events on the Virtual and Calculated Channels views to 
control stop and start logging conditions.

– Detection (high, low, outside/inside range)

– Action (turn logging on/off, write analog output value, write to 
digital line, send an email, and make a sound)

Once you have defined a task, you can easily execute it and view the data. 
With the calculated channels feature, you can perform mathematical 
functions on virtual channels and log these calculated channels. With 
DataSocket publishing, while logging a task, you can publish data over the 
Internet and retrieve and view the data on a remote computer. 

When a task is finished, you can select all or some of the data and export 
the data to a text file from any specified task run. This text file can be read 
by spreadsheet programs or by a Web browser if you export data using an 
HTML template. Refer to the Loading an HTML Export Template section 
of Chapter 2, Creating and Running a VI Logger Task, for more 
information about using an HTML template to format exported data. You 
also can configure a task to be published to the Web and updated 
automatically. Refer to the Publishing Task Data to the Web section of 
Chapter 2, Creating and Running a VI Logger Task, for more information 
about configuring a logging task to publish data to the Web.

You also can export data to DIAdem to create reports of the logged data. 
Refer to the Launch DIAdem from VI Logger section of Chapter 2, Creating 
and Running a VI Logger Task, for more information about launching 
DIAdem from VI Logger. 

Using VI Logger VIs in LabVIEW
You can add functionality to VI Logger by using the LabVIEW VI Logger 
VIs, to execute data logging tasks and retrieve historical data, in 
conjunction with other LabVIEW VI libraries. For example, use the 
mathematical and analysis functions in LabVIEW to perform real-time 
analysis.
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Checking Your System Requirements
Before you unpack and install the VI Logger software kit, make sure you 
have the following necessary system requirements to run this system:

• Windows 2000/NT/XP/Me/98

• DAQ device and NI-DAQ 7.0 or greater—VI Logger works with 
E Series, NI 435X, and NI 611X devices

• FieldPoint device and FieldPoint 4.0 or later—VI Logger with 
FieldPoint devices and FieldPoint 4.0 or later.

Installing Your Hardware
For instructions for installing your hardware, refer to the hardware 
installation document.

Installing VI Logger
To install VI Logger, insert the VI Logger CD in the CD-ROM drive, and 
follow the instructions that appear on your screen. Click Finish when the 
installation is complete. You then can access the VI Logger utility through 
MAX. Refer to Chapter 2, Creating and Running a VI Logger Task, for 
more detailed instructions on using VI Logger.

Configuring and Testing Your Hardware
Once you have installed your hardware, configure and test it using the 
instructions contained in your hardware installation guide or user manual.
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2
Creating and Running a 
VI Logger Task

This chapter explains how to configure and run a task using VI Logger and 
how to view or export the resulting data. 

Configuring, Modifying, and Testing 
Your Measurement Device

Before you create a VI Logger task, you should configure and test at least 
one measurement device and one virtual channel or FieldPoint item to 
verify the operation of your data logging hardware. While most DAQ 
devices that are supported by VI Logger are plug and play, you should 
make sure that they are set up correctly. In the Devices and Interfaces 
category of the Measurement & Automation Explorer (MAX), check to see 
if your device is listed. Modify and test the device by selecting it and using 
toolbars supplied with the device.

Note If you have a plug and play device and it does not appear under Devices and 
Interfaces in MAX, press <F5> to refresh the list of devices. If it still does not appear, then 
refer to the installation instructions for the NI-DAQ board.

Using Virtual Channels with VI Logger
Before you create a VI Logger task for an NI-DAQ traditional virtual 
channel, you need to first create the virtual channel and test it. 

Creating Virtual Channels
Complete the following steps to create the traditional virtual channels to 
use in a data logging task.

1. Launch the Measurement & Automation Explorer.

2. In the MAX configuration tree, right-click Data Neighborhood and 
select Create New from the pop-up menu.
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3. The Create New wizard opens. Select Traditional NI-DAQ Virtual 
Channel and follow the wizard instructions to create a new virtual 
channel.

Modifying Virtual Channels
Complete the following steps to modify a virtual channel.

1. In the configuration tree of MAX, right-click a virtual channel under 
Data Neighborhood.

2. Select Properties.

3. Make any modifications necessary in the Configuration dialog box 
that appears.

4. Click OK when you are finished.

Testing Virtual Channels
The Virtual Channel Test Panels show actual readings so you can directly 
control the different channels you have configured. Complete the following 
steps to test the virtual channels.

1. In the configuration tree of MAX, right-click a virtual channel under 
Data Neighborhood.

2. Select Test.

3. View the readings and change any parameters in the Virtual Channel 
Test Panels dialog box.

4. Click Close when you are finished.

Using FieldPoint Items with VI Logger
A FieldPoint item is one or more channels or variables in a FieldPoint bank 
that can be monitored or controlled by MAX. Before you create a 
VI Logger task for a FieldPoint item, you need to first create the FieldPoint 
item and test it.

Creating FieldPoint Items
Complete the following steps to create the FieldPoint items to use in a 
logging task.

1. Right-click a device under My System»Data Neighborhood»
FieldPoint Items and select Create New Item. 

2. In the Create New I/O Item dialog box that appears, select IO Item 
and click Next. 
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3. In the Create New I/O Item dialog box, you can rename the new item, 
select the advise rate and type, and select channels to include.

4. Select Tools»FieldPoint»Save to save the FieldPoint item 
configuration (.iak) file. You cannot run a VI Logger task for a 
FieldPoint item until you have saved the .iak file.

Refer to the Measurement & Automation Explorer Help for FieldPoint for 
more information about configuring FieldPoint items in MAX.

Note For information on panel items or buttons, right-click an item and select 
What’s This?.

Creating and Configuring a Task
When you configure a logging task, VI Logger provides feedback if any 
choices you make are invalid. Complete the following steps to create a data 
logging task.

1. Launch VI Logger by selecting Start»Programs»National 
Instruments»VI Logger. 

2. In the configuration tree in MAX, right-click VI Logger Tasks and 
select Create New. The Create New dialog box appears.

3. Select NI-DAQ Task or FieldPoint Task and click Finish. In the 
MAX configuration tree, the newly created task is selected and the 
Task Attributes view is selected. 
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Figure 2-1.  NI-DAQ Task Attributes

VI Logger automatically gives the task a unique default name, which 
appears in the task name field as NI-DAQ Task or FieldPoint Task. You 
can rename the task by deleting the default task name and entering a new 
name in the task name field.

The Task Attributes view will look different for NI-DAQ tasks and 
FieldPoint tasks. 
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Figure 2-2.  FieldPoint Task Attributes

4. In the Acquisition Settings section, enter the following fields:

a. In the Device field, select the device you are using.

b. In the Scan Rate field, use the default scan rate or enter the rate at 
which you want to acquire data per second.

Note The Scan Rate field determines the number of scans per second for NI-DAQ tasks 
and the number of seconds to skip between scans for FieldPoint tasks.

5. (FieldPoint Tasks) In the FieldPoint configuration file field, enter or 
browse to the path of the FieldPoint configuration file to use.

6. (NI-DAQ Tasks) In the Buffer Settings section, you can define buffering 
parameters for the task. With these parameters, you can modify the 
performance of VI Logger, specifically if you are trying to log data at 
a high rate.

Tip You cannot log data from more than one NI-DAQ device per task. However, you can 
define one task for each device and can run more than one task at the same time.
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Setting Up Channels in a VI Logger Task to Acquire and Log Data
For each VI Logger task you configure, you can select which specific 
channels acquire and log data within that task.

Setting Up the Virtual Channels in a NI-DAQ Task to 
Acquire and Log Data
For each NI-DAQ task you configure, you can select which specific 
channels acquire and log data within that task. 

Complete the following steps to set up the channels that acquire and log 
data.

1. With an NI-DAQ Task selected, click the Virtual Channels tab to 
open the Virtual Channels view. The following configuration view 
appears. 

2. Right-click the Events column heading and select Events to enable or 
disable the information displayed in the table. Refer to the 
Measurement & Automation Explorer Help for VI Logger, by selecting 
Help»Help Topics»VI Logger»VI Logger Help for more 
information about the information columns in the Virtual Channels 
view.

 

3. The Active Channel column displays all the virtual channels you have 
created in MAX for your device. To enable logging for each channel, 
place a checkmark in the Log Enabled? checkbox to the right of each 
channel name.
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Tip To add a virtual channel, click Create channel and follow the instructions in the 
Create New Channel wizard.

Refer to the Creating Calculated Channels section for information about 
creating calculated channels for VI Logger tasks.

Setting Up the FieldPoint Channels in a FieldPoint 
Task to Acquire and Log Data
For each FieldPoint task you configure, you can select which specific 
channels acquire and log data within that task. 

Complete the following steps to set up the channels that acquire and log 
data.

1. With a FieldPoint task selected, click the FieldPoint Channels tab to 
open the FieldPoint Channels view. The following configuration view 
appears. 

2. Right-click the Events column heading and select Events to enable or 
disable the information displayed in the table. Refer to the 
Measurement & Automation Explorer Help for VI Logger Help for 
more information about the information columns in the FieldPoint 
Channels view.

 

3. The Active Channel column displays all the FieldPoint channels you 
have created in MAX for your device. To enable logging for each 
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channel, place a checkmark in the Log Enabled? checkbox to the right 
of each channel name or double-click the FieldPoint channel in the 
FieldPoint tree view.

Tip To add a FieldPoint channel, right-click a device under My System»Data 
Neighborhood and select Create New Item. Save the FieldPoint configuration (.iak) file 
because you cannot run a VI Logger task for a FieldPoint item until you have saved the 
.iak file.

4. To configure an event, right-click the Events column and select 
Events. Check and uncheck the desired events. You also can 
right-click the table cells to access more options to modify these 
conditions.

Refer to the Creating Calculated Channels section for information about 
creating calculated channels for VI Logger tasks.

Configuring Events for a Logging Task
You can configure events to be logged in your task that will appear in the 
Events view. Complete the following steps to configure the events for a 
logging task.

1. In the NI-DAQ Channels or FieldPoint Channels view, right-click the 
Channels column and select Events. 

2. Check and uncheck the desired events to select which events to display 
for the channels. 

3. You also can right-click the table cells to access more options to 
modify these conditions.

Creating Calculated Channels
You can set up mathematical equations that use virtual channels or 
FieldPoint channels using math channels. For example, for channels 
Channel 0 and Channel 1, you could enter the equation Channel 0 - 
Channel 1, to subtract one from the other. The result would be a 
calculated channel.

Complete the following steps to create a calculated channel.

1. Click the Calculated Channels tab to display the Calculated Channels 
view.

2. Click Create channel. The Math Expression Editor dialog box 
appears where you can define a math channel.
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3. In the Channel Settings section in the Name field, enter an 
appropriate name for the math channel.

4. In the Units field, enter the appropriate unit type.

5. In the Minimum and Maximum fields, enter a range of units that 
applies to the math channel.

6. In the Formula Settings section in the Formula field, click the down 
arrow, and select one of four formulas to apply to the math channel:

• Ax (Op) By + C—A linear combination formula. Fill in fields A, 
Channel X, Operation, B, Channel Y, and C with the 
appropriate values.

• db x/y—A measurement of noise (db)–power base 10. Select the 
channels you want for Channel X and Channel Y fields.

• dBVx—A single channel noise measurement. Select the channel 
you want for the Channel X field.

• User Defined—A formula that you create. Refer to Appendix A, 
Math Expression Editor Function Descriptions, for more 
information about the valid functions you can use in this field.

7. Click OK.
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Advanced Task Settings
VI Logger tasks have advanced settings that are not in the Task Attributes 
view. To configure the advanced settings for a task, click the Advanced 
task settings button on the Task Attributes view.

Logging Event Data to a Text File
You can specify a text file for VI Logger to enter event data from logging 
tasks. Complete the following steps to log event data to a text file.

1. Click the Task Attributes tab to open the Task Attributes view for a 
FieldPoint or NI-DAQ task.

2. Click the Advanced task settings button to launch the Task 
Properties dialog box.

3. Place a checkmark in the Log Events checkbox on the Advanced 
Task Settings tab.

4. Enter a File Name or browse to a text file where you want to send 
events data from a logging task.

5. Click Apply to save the setting or OK to save the memo and close the 
Task Properties dialog box.

Launch DIAdem from VI Logger
DIAdem is an interactive post-acquisition data analysis and report 
generation software that can import VI Logger task data. Complete the 
following steps to launch DIAdem opened to your task data. 

1. Click the Task Attributes tab to open the Task Attributes view for a 
FieldPoint or NI-DAQ task.

2. Click the Advanced task settings button to launch the 
Task Properties dialog box.

3. Place a checkmark in the Launch DIAdem after task completes 
dialog box. 

4. Click Apply to save the setting or OK to save the memo and close the 
Task Properties dialog box.

Setting Up Network Publishing to View Data from Another Computer
With network publishing, on the host computer, you can specify a specific 
URL where you want to publish the data so you can monitor the data from 
that location. You can use LabVIEW to create a DataSocket client for 
the Web.
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Complete the following steps to publish data using a network.

1. Click the Task Attributes tab to open the Task Attributes view for 
a FieldPoint or NI-DAQ task.

2. Click the Advanced task settings button to launch the Task 
Properties dialog box.

3. In the Network Publishing section, place a checkmark in the 
Publish to DataSocket checkbox.

4. In the URL field, enter a URL of a client computer from where you 
want to monitor the data being acquired and logged from a task.

5. Click Apply to save the setting or OK to save the memo and close the 
Task Properties dialog box.

If you have LabVIEW, refer to the DataSocket Reader.vi in the 
examples\VI Logger\Reading Examples.llb to view the data from 
the client computer.

Entering a Task Memo
You can enter a description or other information about a logging task. 
Complete the following steps to enter extra information about a logging 
task.

1. Click the Task Attributes tab to open the Task Attributes view for a 
FieldPoint or NI-DAQ task.

2. Click the Advanced task settings button to launch the Task 
Properties dialog box.

3. Enter a description or other extra information in the Task Memo field.

4. Click Apply to save the memo or OK to save the memo and close the 
Task Properties dialog box.

Publishing Task Data to the Web
Use VI Logger to publish data on the Web. Click the Advanced task 
attributes button in the Task Attributes view and click the Publish to the 
Web tab. Select which channels to publish, the timespan of the data 
displayed, and how often to update the .htm file. You also can use FTP to 
send the generated .htm file to a remote computer, such as a Web server. 

Note The VI_Logger_Web.html file must be in a folder named source in the same 
directory that you publish task data to for the data to be formatted correctly.
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You also can store data on an FTP site in this dialog box by placing a 
checkmark in the Store HTML files on FTP checkbox, and entering the 
relevant information about the FTP site.

Modifying a Task
Once you have created a task, you may want to modify the task. Complete 
the following steps to modify a task.

1. In the MAX configuration tree, expand VI Logger Tasks. Click the 
task name. The summary of the task configuration appears in four 
views in the configuration view: Task Attributes, FieldPoint Channels 
or Virtual Channels, Calculated Channels, and Real Time Data. To 
access one of these views, click the tab at the bottom of the MAX 
screen.

2. Modify the task by changing any information in the appropriate fields.

You are now ready to run the new data logging task. Running a task 
automatically saves the modified task.

Duplicating a Task
To save time when configuring more than one task, you can duplicate a task 
and then modify anything in it. Complete the following steps to duplicate a 
task.

1. Right-click the task in the MAX configuration tree and select 
Duplicate. The Duplicate a VI Logging task dialog box appears.

2. Enter a task name in the New task name field.

3. Click OK. 

The duplicate task appears in the MAX configuration tree at the end of the 
task tree.
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Deleting a Task and Data
Complete the following steps to delete an entire task.

Caution When you delete a task, all data associated with that task will also be deleted.

1. Right-click the task in the MAX configuration tree and select Delete. 
A MAX-VI Logger dialog box appears asking you to confirm that you 
want to delete the task.

2. Click Yes to delete the task or click No to cancel the deletion.

Running a Task
Complete the following steps to run a task.

1. Select the task you want to run in the MAX configuration tree.

2. Click the Run Task button below the menu toolbar. 

Let the task run for several seconds to acquire some data. Click Stop Task 
to stop running the task, or wait for a stop condition or trigger to occur. The 
data is collected and stored by MAX. You may also store the data by 
enabling the Publish to DataSocket checkbox in the Task Attributes view 
to send the data to DataSocket to view from a remote computer.

Stopping a Task
If you set a stop condition for a task, it stops acquiring and logging 
automatically. If you do not specify stop conditions when you create a task, 
the task runs until you manually click the Stop Task button in the MAX 
toolbar.
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3
Setting the Logging and Data 
Acquisition Conditions

You can define both logging and acquisition conditions for a task. Logging 
occurs when the data is actually being logged to where you want to store 
the data. Acquisition occurs when the data is being acquired and is 
available for viewing in the Real Time Data view. The data is not 
necessarily being logged anywhere, although you can both acquire and log 
data at the same time. 

Using the Default Acquisition and Logging Settings 
for a Task

The Begin logging when acquisition starts checkbox in the Task 
Attributes view, Logging Conditions section is enabled by default. When 
you use the default logging and acquisition settings for a task, you can 
optionally set the acquisition stop condition and then save and run the task 
with this condition, or you can click the Stop Task button in the 
Measurement & Automation Explorer (MAX) toolbar to stop acquisition. 
After you click Run Task, both the data acquisition and the logging 
immediately start at the same time. Logging and acquisition stop when you 
click the Stop Task button or when a stop acquisition condition is met. The 
following figure illustrates this default scenario.
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Refer to the Setting a Stop Condition for Acquiring Data section for more 
information about how to set an acquisition stop date and time.

Using Conditional Acquisition for a Task
In addition to setting up start and stop conditions for logging, you also can 
set start and stop conditions for acquiring data in a task. Refer to the Using 
Conditional Logging for a Task section for more information about how to 
set up conditional logging conditions in a task. 

Setting Up Pretriggering
Pretriggering enables you to view the data from a specific number of scans 
prior to an event condition trigger. 

Note Pretriggering only is available with NI-DAQ virtual channels.

Complete the following steps to set up pretriggering.

1. In the Pretriggering section of an NI-DAQ Task Attributes view, place 
a checkmark in the Enable checkbox.

2. Enter a number in the Number of Scans field to determine how many 
scans to view data for before an event trigger occurred.

When You...

VI Logger...

Click Stop Task, or the Acquisition
Stop Condition is Met,

Stops Acquiring
and Logging Data.

Click Run Task,

Starts Acquiring
and Logging Data.

VI Logger Task: Acquisition and Logging
Logging Task

Data Acquisition

Logging Operation
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Setting Start Conditions for Acquiring Data
There are three ways to start acquiring data:

• Start acquisition on a particular date and time. 

• Start acquisition with a trigger. 

• Use a combination of the two above, where the NI-DAQ or FieldPoint 
hardware searches for a digital trigger after a specific start time is met. 
Refer to the Using Both Conditional Acquisition Triggers and 
Conditional Logging for a Task section for more information about 
using both.

Note When you start acquisition, you start acquisition on the channels selected in the Log 
Enabled? column of the Channels view for a task. 

Setting a Date and Time Start Condition for Acquiring 
Data
Complete the following steps to set an acquisition start condition using a 
date and time.

1. Click the Task Attributes tab to open the Task Attributes view.

2. In the Acquisition Conditions, Date and Time section, place a 
checkmark in the Start acquisition checkbox.

3. Enter a date and time when you want to start acquiring data.

To begin acquiring data, click Run Task. To stop acquiring data, either 
wait for the stop acquisition date and time to be met or click the Stop 
Task button.

4. Verify changes to the acquisition settings by clicking Save Task.

Setting a Trigger Start Condition for Acquiring Data
Complete the following steps to set the acquisition start conditions using a 
trigger.

1. Click the Task Attributes tab to open the Task Attributes view.

2. In the Acquisition Conditions, Trigger section, place a checkmark in 
the Start acquisition on trigger checkbox to apply any triggered start 
conditions to a task.

3. In the Acquisition Conditions, Trigger section, select the appropriate 
start conditions in the active fields that apply to the trigger. To get a 
more detailed description of what each field does, right-click the label 
and select What’s This?.
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Setting a Stop Condition for Acquiring Data
You can set a stop condition for the task to stop acquiring data for a date 
and time. You also can stop the task by manually selecting the Stop Task 
button. Complete the following steps to set the date and time stop 
condition.

1. Click the Task Attributes tab to open the Task Attributes view.

2. In the Acquisition Conditions, Date and Time section, enable the 
Stop acquisition checkbox.

3. Enter a date and time when you want the task to stop acquiring data.

To begin acquiring data, click Run Task. To stop acquiring data, either wait 
for the stop acquisition date and time to be met or click the Stop Task 
button.

Note When you set the acquisition start and stop conditions, you still need to start the task 
manually by clicking Run Task. Once you have begun the task, VI Logger waits for the 
appropriate start conditions to begin acquiring data, and then stops when the stop condition 
is met.

The following figure demonstrates what happens in VI Logger when you 
set start and stop conditions for data acquisition.
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Logging Task

Data Acquisition
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Setting Up Finite Acquisition
For NI-DAQ tasks, you can enable finite acquisition. In the Task Attributes 
view, place a checkmark in the Finite Acquisition checkbox and enter a 
Number of Scans to stop data logging after the entered number of scans is 
acquired.

Note Finite acquisition only is available with NI-DAQ virtual channels.

Using Conditional Logging for a Task

Note Turning logging on and off does not affect the task. Click Stop Task or set a stop 
task condition to stop logging.

You either can log some or all of the channels within a task. You can 
configure the task to start logging when you run the task, or you can 
configure an event to start logging data. Use the Control logging with 
digital channel checkbox on the Task Attributes view to control logging 
for the task. You configure events to control logging by right-clicking the 
Events column of the table in the Virtual Channels, FieldPoint Channels, 
or Calculated Channels view, and selecting Events. Check or uncheck 
events from the drop-down menu to configure logging events. The 
following figure illustrates what happens in VI Logger when you set up 
conditional logging.
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There are three ways to control the logging of a task: default settings, 
channel events, and conditional acquisition triggers and conditional 
logging.

Using Default Settings for Logging
You can use the default settings to control logging for a task. When you use 
the default settings, logging starts when you click Run Task and stops 
when you either click Stop Task or a stop data acquisition condition is met. 
Refer to the Setting Up an Event Detection section for information about 
using events to control logging.

Using Channel Events for Logging
You also can control start and stop logging conditions. Refer to the Setting 
Up an Event Detection and Setting Up an Event Action sections for more 
information about using the channel events feature. 

Note This feature is available for virtual, FieldPoint, and calculated channels. When the 
term channel is used throughout this section, it is referring to virtual, FieldPoint, and 
calculated channels.
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Setting Up an Event Detection
An event is similar to a trigger. When a specific condition occurs, 
VI Logger performs a specified action. The specific condition is called an 
event detection. You only can configure one event per channel. By default, 
all channels are configured without an event defined for them.

Complete the following steps to set up event detection.

1. In the Virtual Channels, FieldPoint Channels, or Calculated 
Channels view, in the Active Channel field, right-click the channel 
name for which you want to set an event.

2. Select Events to open the Event properties for dialog box.

3. Click the Event Detection tab.
 

4. Under Event Type, select the type of event. The type of event you 
select determines which fields may appear in the dialog box for you to 
customize.

• If you select Outside Range in the Event Type field, in the 
Range Min and Range Max fields, enter the minimum and 
maximum range for the event.
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• In the Deadband field, enter a value to prevent noise in the signal 
from triggering multiple events. A higher value provides greater 
noise immunity. The value is in the same units as the channel.

• In the High field, enter a high limit to trigger a High, Outside 
Range, or Inside Range event. The units are the same as for the 
channel.

• In the Low field, enter a low limit to trigger a Low, Outside Range, 
or Inside Range event. The units are the same as for the channel.

Refer to the Setting Up an Event Action section for more information about 
finishing configuring the task event.

Setting Up an Event Action
The event action is what you want done once VI Logger detects the specific 
event condition. Complete the following steps to set up event action.

1. Click the Event Action tab. The Event properties for dialog box 
appears.

 

2. Under Action Type, click the down arrow and select an event action. 
As necessary, customize any additional fields that appear when you 
make a selection.
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The event actions that you can select are as follows:

• No Action—Nothing happens when VI Logger detects an event 
condition.

• Write to Digital Line—Writes to a digital output line.

• Write to Analog Channel—Writes to an analog output channel.

• Display Event Message—Message appears.

• Send Email Message—Sends email to the user account. Refer to 
Appendix B, Setting Up an Event Email, for more information 
about sending an email message when an event occurs.

• Sound—Use multimedia, such as a beeping terminal (sound).

• Toggle Logging—Changes between logging on and logging off 
states.

• Turn Logging Off—Turns logging off when the event detection 
condition occurs.

• Turn Logging On—Turns logging on when the event detection 
condition occurs.

3. Click OK to save the new event detection and action settings for the 
event.

4. Click Save Task to save changes to the task.

Refer to the Modifying a Task section of Chapter 2, Creating and Running 
a VI Logger Task, for more information about modifying a task before 
running.

Using a Digital Channel to Control Logging

Note To use a digital channel to control logging, you must already have a virtual channel 
or FieldPoint channel set up for digital line input.

You can wire a hardware switch to one of the digital input virtual channels 
or FieldPoint channels to control when a task logs. When the line is high, 
logging is enabled. When the line is low, logging is disabled. Refer to your 
device documentation for more information about setting up a hardware 
switch.
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Complete the following steps to set up the start conditions for logging a 
task.

1. Verify you have a digital input channel for which to toggle logging. 

2. In the MAX configuration tree under Data Neighborhood, right-click 
the digital input line virtual channel and select Test. Test the virtual 
digital input channel by flipping the hardware switch on or off and 
verifying if it powers on or off the LED in the software test panel 
in MAX. 

3. In the Task Attributes view in the Logging Conditions section, select 
Control Logging with digital channel. 

4. Select the Digital channel name.

As you toggle the hardware switch, you toggle the data logging on or off. 
Each time you turn logging on, a new date and time run appears under the 
VI Logger task name in the MAX configuration tree.

Using Both Conditional Acquisition Triggers and 
Conditional Logging for a Task

The following figure illustrates what happens in VI Logger when you set 
up both conditional acquisition and conditional logging. If you set the start 
time for acquisition and a trigger for starting logging, the start time begins 
acquisition, the trigger begins logging, and then the logging conditions are 
evaluated. Refer to the Using Conditional Acquisition for a Task section for 
more information about setting up conditional acquisition and conditional 
logging.
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4
Viewing and Printing Your Data

VI Logger lets you view data as it is logged in the Real Time Data view and 
already logged data in the Historical Data view. You can print both views.

Viewing Data

Tip You can move all of the VI Logger views, such as Task Attributes and Calculated 
Channels views around to dynamically interchange them. You also can separate the view 
from the Measurement & Automation Explorer (MAX) interface by clicking the tab of the 
view and dragging the view away from the MAX dialog box.

When you view logged data, you can view data such as the start and stop 
time, engineering units measured, minimum and maximum value set for the 
channel after scaling, and number of scans. In addition, you can view data 
in a display view before, during, or after the data is logged. Complete the 
following steps to view the logged data.

1. In the MAX configuration tree under VI Logger Tasks, click a task 
name.

2. Click the run you want to view.

3. If not already selected, click the Trace Attributes tab to open the 
Trace Attributes view. The following configuration view appears for an 
NI-DAQ task.
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Figure 4-1.  NI-DAQ Trace Attributes View

From this view, you can find the following information about the task
you ran:

• Start time—Time task began.

• End time—Time task ended.

• Name—Channel name from which the data was logged.

• Units—Engineering units measured.

• Minimum—Minimum value set for that channel after scaling.

• Maximum—Maximum value set for that channel after scaling.

• # of Scans—Number of times the channel was scanned.

• Scaled—Yes means the data was scaled before it was logged. 
No means the data was not scaled before it was logged.
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The following configuration view appears for FieldPoint tasks.

Figure 4-2.  FieldPoint Trace Attributes View

Viewing Data Graphically
Click the Historical Data tab to open the Historical Data view at the 
bottom of the configuration view to see the graphical view of the data 
logged from each channel. 

Monitoring Acquired Data
There are two views available where you can view data. The first display 
view, Real Time Data, is available when you select a task name in the 
Configuration view. You can use this display to monitor data that is being 
acquired, regardless of if the data is being logged or not. VI Logger 
automatically jumps to this view to monitor the data when logging starts. 
For high-speed data logging, you can disable this default behavior by 
removing the check from the Jump to the Real Time Data tab when task 
starts checkbox on the Task Attributes view.
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Viewing Logged Data
The Historical Data view appears when you select a run under the task 
name. This view shows only logged data that has already been stored in the 
task run, as shown in Figure 4-3.

Figure 4-3.  NI-DAQ Task Historical Data View

For information about the controls and features of the Historical Data view, 
right-click in the graph and select Help.

Plotting Data
A red and green LED indicator appears on the upper right corner of the 
Historical Data and the Real Time Data views when you are running a task. 
If the green light is lit, you are viewing the task data while it is being 
acquired, and the data on the screen reflects what is currently being 
acquired. If the red light is lit, you are viewing the data that has already 
been collected and logged.

• To switch between viewing current and historical data, click the LED 
indicator. You only can switch between viewing current and historical 
data if a task is running.
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• To snap the view to the beginning of the logged data, click the home 
arrow button. To snap the view to the end of the data, click once on the 
end arrow button.

• To scroll back and forth through the logged data, click the forward or 
backward scroll arrows. To scroll faster through the data, click the 
forward or backward scroll arrow buttons, and drag the cursor to the 
right or left of the arrow buttons while holding the mouse button down. 
The further away you drag the cursor from the arrow, the faster the data 
scrolls.

Zooming In or Out on Data
Click the magnifying glasses at the top of the display view to zoom in or 
zoom out on the current view. The view is magnified twice or decreased by 
half on the x-axis as you zoom in or out.

Additionally, in the display view, you can click and drag to the right or left 
to zoom in on the x-axis data. You also can right-click in the view, select 
Zoom/Pan Mode, then click in the view and drag the square for the x- and 
y-axis area you want to magnify. Select the zoom out magnifying glass to 
zoom out again.

Modifying Plots or Display View
Complete the following steps to modify plots or display view.

1. Right-click in the graphical view and select Properties. The 
HyperTrend Properties dialog box appears.
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Figure 4-4.  NI-DAQ Task HyperTrend Properties Dialog Box

2. Select a Group from the Groups drop-down list or use the Add and 
Del buttons to add or delete a group. In the Groups section, you can 
modify the group using the following fields:

• Name—Specifies the group display plots and view that you are 
modifying 

• Caption—Describes the group and the text then appears beneath 
the Real Time Data view 

• Width—The default width of the entire Real Time Data view is 
one second from beginning to end. You can enter any time frame 
in the Width field to change what amount of data you see in the 
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view. Once you are in the Real Time Data view and you make 
modifications to the width of the view, you can right-click and 
select Restore X-axis width to return to the default width.

• Major Grid—Click the down arrow to modify the color of the 
major grid lines. Select the Visible box if you want the major grid 
lines to show. 

• Minor Grid—Click the down arrow to modify the color of the 
minor grid lines. Select the Visible box if you want the minor grid 
lines to show.

• Background—Click the down arrow to modify the background 
color of the Real Time Data view.

3. In the Y-Axes section, configure the y-axis settings for the selected 
group.

• Use the pull-down menu to select a y-axis, or click the Add or 
Del buttons to add or remove y-axes. 

• Enter a Caption to display next to the y-axis. 

4. Under Channels/Traces, select the channel on which the task ran. 
Click the up and down blue arrows to change the order of the channels 
as they appear to the right of the display. Additionally, you can edit or 
delete the selected channel from the view by clicking the Edit and 
Del buttons.

5. In the Channels/Traces section, you can modify a channel or trace 
display with the following fields:

• Name—The name of the channel appears in this field.

• Minimum and Maximum—Enter a number to adjust the y-axis 
height of the plot.

• Y-Axis—Enter a caption to display next to the selected y-axis.

• Line—Click the down arrow button to select a line color. You also 
can modify the style and width in the Style and Width fields next 
to the color.

• Data Point—Click the down arrow button to select a line color. 
You also can modify the style in the Style field next to the color.

• Event—Click the down arrow to select a line color. You also can 
modify the style and width in the Style and Width fields next to 
the color.

6. Click Apply to apply the changes to the Real Time Data view.

7. Click OK to exit the HyperTrend Properties dialog box.
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8. Right-click in the Real Time Data view and select Fixed Grid to make 
additional modifications to the view. With this feature checked, the 
grid stays in one place while the data still scrolls in the view. With this 
feature unchecked, the grid moves with the data as it scrolls.

Modifying the Legend
The legend is the area to the right of the display view that shows channel 
names from which the data is taken. Complete the following steps to 
modify the legend or channels in the legend.

1. Right-click the channel name you want to modify in the legend and 
select one of the following items:

• Display—When you check this item, it displays the channel you 
selected in the legend and shows the data plot from that channel in 
the view.

• Hide—When you check this item, it grays out the channel you 
selected in the legend and does not show the data plot in the view. 
You also can double-click the channel name to hide it. To display 
the channel again, double-click the grayed out channel name.

• Select All—When you check this item, it selects all the channels 
in the legend so you can modify them all at once. You also can 
select more than one channel by pressing <Ctrl-Shift> while 
clicking a channel.

• Rename—You can enter a different channel name when you 
select this item.

2. To hide or show the legend, right-click in the graph area, and select 
Show Legend, depending upon which is needed.

3. Click the channel name colored box to change the plot color in 
the view.

Determining Time Difference, Frequency, 
and Values Using Plot Cursors

If you have a periodic waveform to view, use this feature to measure the 
time difference between two points in the display or to calculate the 
frequency of a periodic waveform. You can see the value of a plot wherever 
you place a cursor, which appears as a green vertical line in the displays 
view. You also can get the time difference between two cursors that you 
place on the plot, and you can get the inverse of that, which is the 
frequency. 
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Complete the following steps to change the cursor displays.

1. Click the Cursor button located above the display view to access the 
Display Cursors dialog box.

2. Select the Two Cursors box to be able to use two cursors at the same 
time in the view.

• First Cursor and Second Cursor—Modify the date and time of 
where the cursor is placed in the view using these fields. If you run 
the task for more than one day, then you might need to modify the 
day.

Note Time Diff and Freq fields are hidden if the Two Cursors checkbox is not checked.

• Time Diff—The time difference is calculated between the two 
cursors. The maximum time that will show in this field is the 
maximum width of the view window. 

• Freq—The frequency (inverse of the Time Diff field).
 

Figure 4-5.  NI-DAQ Task Hypertrend Cursors Dialog Box

3. Click Close to exit from the dialog box.
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Viewing Events
The Events view displays all event messages that occur during a logging 
task and all VI Logger error messages and warnings. You can right-click 
anywhere in the Events view to Auto Scroll through the view, to Clear 
Display, and to Save All or Save Selected events.

Refer to the Setting Up the FieldPoint Channels in a FieldPoint Task to 
Acquire and Log Data section of Chapter 2, Creating and Running a 
VI Logger Task, for more information about how to set up event logging. 

Enable Auto-Scrolling
Auto-scrolling allows you to view the most recently logged data by 
scrolling the Events view down automatically as events are logged. To 
enable auto-scrolling, right-click the Events view and select Auto Scroll.

Saving Events
Complete the following steps to save logged events to a tab-delimitated 
text file.

1. Open the Events view by clicking the Events tab.

2. Right-click in the Events view.

• Select Save All Events to save all of the events for the logging 
task.

• Select Save All Selected Event(s) to save the selected events or 
event in the Events view. 
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3. Enter a file name for the file that will contain the events data and click 
Save. 

4. Click OK.

Clear Events View
To clear the Events view of all logged events, right-click the Events view 
and select Clear Display.

Printing Data
To print the data graph, right-click in the Historical Data or Real Time Data 
display view and select Print. You only can print what is showing in the 
view on your screen.
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5
Exporting Data and 
VI Logger Databases

You can export VI Logger data to a .txt or .html file to publish to the 
Web and to DIAdem. Refer to the Launch DIAdem from VI Logger and 
Publishing Task Data to the Web sections of Chapter 2, Creating and 
Running a VI Logger Task, for more information about exporting VI 
Logger data to DIAdem and publishing a .html file of exported data to 
the Web. You can also export VI Logger tasks in XML format to another 
computer.

Exporting Data
To export data to another file, under VI Logger Tasks, right-click a run, 
and select Export Data. The Export data dialog box appears as shown in 
the following figure.
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• Source—File path where the database source to export is located.

• Start time—Time stamp on the first point returned in the data plot. 
You can manually change this field. This date and time are the 
startDate and startTime variables in the Advanced export settings 
dialog box.

• End time—Time stamp on the last point returned in the data plot. You 
can manually change this field. This date and time are the endDate and 
endTime variables in the Advanced export settings dialog box.

• Field Delimiter—Use this option to select what is placed between the 
different fields in the data in the export file. For example, you can 
separate the fields in the export file with a comma or a tab. This field 
is the delimiter variable in the Advanced export settings dialog box.

• Output file—File path where data is exported. You need to name the 
export file in this field before you generate it. Use any file extension 
and include the complete path to the file.

• Writing rows—Progress bar that monitors the export function.

• Start—Starts generating the export file.

• Cancel—Interrupts the export function and exits the Export data 
dialog box without saving any changes.

• Advanced—Accesses the advanced programming options, such as the 
header and footer formats, and variables you want to appear in the 
export file. Refer to the Setting Advanced Export and Programming 
Options section for more information about advanced export options.

Setting Advanced Export and Programming Options
To access the advanced programming options feature, click Advanced in 
the Export data dialog box. Refer to the Exporting a Task section for more 
information about exporting data. The Advanced export settings dialog 
box appears, as shown in the following figure.
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• Header format—Enter the header that you want to appear in your 
export file. You can use variables in this field.

• Row format—Enter the way you want the row of data to be formatted. 
You can use variables in this field.

• Footer format—Enter the footer that you want to appear in the export 
file. You can use variables in this field.

• Variables—Select from the variables to determine the row format and 
footer format of your export operation. Refer to the Variables section 
for more information about using variables with VI Logger.

• Load—Click to load predefined templates included with VI Logger or 
a template you created and customized. Refer to the following sections 
for more information about loading templates.

• Save—Click to save any customized formats.
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Loading a User-Defined Export Template
You can load a user-defined template, which is included with the VI Logger 
software. Complete the following steps to load a user-defined template.

1. Right-click a run in the Measurement & Automation Explorer (MAX) 
configuration tree and select Export Data. Click Advanced to open 
the Advanced export settings dialog box.

2. In the Advanced export settings dialog box, click Load. The Load 
export template dialog box appears.

3. Select default.vet from the VI Logger\Export folder and click 
Open. The Advanced export settings dialog box now contains the 
default template settings.

4. Click OK to apply the template formatting to the data you are 
exporting.

Loading an HTML Export Template
You can format data into HTML by loading an HTML template, which is 
included with the VI Logger software. Once you apply the HTML format 
to the data, you then can view the data using a Web browser such as 
Microsoft Internet Explorer. Complete the following steps to load the 
HTML template.

1. Right-click a run in the MAX configuration tree and select Export 
Data. Click Advanced to open the Advanced export settings dialog 
box.

2. In the Advanced export settings dialog box, click Load. The Load 
export template dialog box appears.

3. Select html.vet from the VI Logger\Export folder and click Open. 
The Advanced export settings dialog box now contains the default 
template settings.

4. Click OK to apply the template formatting to the data you are 
exporting.
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Modifying the Template
You can modify the template or create your own template by altering the 
Header format, Row format, and Footer format fields and saving the 
modified template with a new name. Complete the following steps to save 
custom export settings. 

1. Right-click a run in the MAX configuration tree and select Export 
Data. Click Advanced to open the Advanced export settings dialog 
box.

2. In the Advanced export settings dialog box, click Save to save the 
export settings you customize. The Save export template dialog box 
appears.

3. Enter filename.vet.

4. Select the folder where you want to save the new template. The default 
folder is C:\Program Files\National Instruments\ 
VI Logger\Export.

5. Click Save to save your file to this path.

Use variables in the Header Format and Row Format fields of the 
Advanced export settings dialog box to customize an export template. 
Refer to the Export Template Examples section for examples of how to use 
variables in the Header Format and Row Format fields.

Variables
Variables contain values that can vary depending upon the task from which 
you are pulling data. There are two types of variables that you can use to 
program specific text and data into an export file: global and index list row 
format. You can program what variables and text you want to appear in the 
header and footer of the export file using the Header format and Footer 
format fields, and you can program how you want the rows of data to be 
presented using the Row format field. Refer the following tables for 
specific descriptions and categories of the variables.
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Global
Global variables are variables that apply to the entire export file, meaning 
that you can use these variables in all three fields in the dialog box: Header 
format, Row format, and Footer format. 

Global Index
Global variables contain static information with non-changing values.

One Value
One value variables contain only one value.

 Global Function Description

repeat (N, X, Y, “S”) Refer to the Repeat Function section for more 
information about the repeat variables.

 Variable Description

name [N] N=[0...numChannels). Name of channel on the 
N channel trace.

delay [N] N=[0...numChannels). How long it took to 
take measurement from time of scan on the 
N channel trace.

units [N] N=[0...numChannels). Units that appear in the 
VI Logger summary view for the N channel 
trace.

Variable Description

creationDate Date that exported file is created.

creationTime Time that exported file is created.

delimiter The delimiter selected in the Field Delimiter 
field in the Export data dialog box.

deltaT Scan rate (in seconds) for logged task that 
produces plot or run.

endDate End date specified in export dialog box.

endTime End time specified in export dialog box.
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Index List Row Variables
Index List Row variables can be used only in the Row format field and their 
values determine the format of the information in the row. 

One Channel Value in a Row Export Variables
One Channel Value in a Row Export variables values can change within a 
row.

startDate Start date specified in export dialog box.

startTime Start time specified in export dialog box.

numChannels Number of virtual channels or FieldPoint 
channels that appear in the VI Logger Trace 
Attributes view. Amount equals total number 
of channels when you combine the 
numRegChannels and numCalcChannels 
variables.

rows Number of total rows of data exported.

numRegChannels Number of virtual channels or FieldPoint 
channels excluding calculated channel.

numCalcCchannels Number of calculated channels only.

Row Format Variable Description

row Row number (0 to number of scans).

date Date of current row.

time Time of current row.

timeOffset Time of scan since the start of the export: 
Row number × deltaT.

Row Format Variable Description

value[N] N=[0...numChannel). Value of the N channel 
trace in the current row.

Event [N] N=[0...numChannels). Event of the 
N channel trace in the current row.

Variable Description
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Repeat Function
You can use the Repeat (N, X, Y, “S”) function for string replacement. For 
example, you can use this function when you have ten channels in one run, 
five channels in another run, and you need to alter the number of channels 
in the runs.

Special Syntax Characters
There are four different special syntax characters that you can use in the 
repeat function. 

Character Description

N String which needs to be replaced in S.

X Beginning value of N, the valid range is between 
[0..numChannels).

Y Ending value of N, the valid range is between 
[0..numChannels).

“S” Statement whose value N will be replaced.

Syntax Character Description

plain text Any plain text character is output to export file 
verbatim.

[ ] Used for channels. Only for indexing into a 
variable that has multiple channels.

" " Whatever text or characters are inside the quotes 
are output verbatim in the export file.

\ Outputs verbatim whatever follows the backslash, 
unless the backslash is inside quotes.

{ } Indicates the start or end of the variable or 
function.
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Export Template Examples
Use the following export template examples to format data logged with 
VI Logger.

Export All Channels Plus Associated Events
The following examples are for the Advanced export settings dialog box 
fields.

Header Format
Enter the following text in the Advanced export settings dialog box fields 
to export all channels and events.

NI (c) VILogger

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of total channels: {numChannels}

row {delimiter} time{delimiter} 

{repeat(###,0,{numChannels},"{name[###]} {delimiter} 

{name[###]}."event" {delimiter}")}

Row Format
{row} {delimiter} {time} {delimiter} {repeat(###, 0, 

{numChannels}, "{value[###]} {delimiter} {event[###]} 

{delimiter}")}

Export Regular Virtual and FieldPoint Channels Only
Enter the following text in the Advanced Export settings dialog box fields 
to export only virtual and FieldPoint channels.

Header Format
NI (c) VILogger

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of virtual channels: {numRegChannels}

row {delimiter} time{delimiter} 

{repeat(###,0,{numRegChannels},"{name[###]} 

{delimiter}")}
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Row Format
{row} {delimiter} {time} {delimiter} {repeat(###, 0, 

{numRegChannels}, "{value[###]} {delimiter}")}

Export Calculated Channels Only
Enter the following text in the Advanced Export settings dialog box fields 
to export only calculated channels.

Header Format
NI (c) VILogger

Created: {creationDate} {creationTime}

Number of scans: {rows}

Scan rate: {deltaT} seconds

Number of calculated channels: {numCalcChannels}

row {delimiter} time{delimiter} 

{repeat(###,{numRegChannels},{numChannels},"{name

[###]}{delimiter}")}

Row Format
{row}{delimiter}{time}{delimiter}{repeat(###, 

{numRegChannels},{numChannels},"{value[###]}

{delimiter}")}

Exporting a Task to Another Computer
You can export a defined task in XML format and import it to a destination 
computer. To export a task to another computer, you need to set up the 
DAQ configuration and the task on the destination computer. On the 
destination computer, you either can use the same DAQ hardware 
configuration as the source computer or you can access the source 
computer DAQ hardware configuration remotely from the destination 
computer. Refer to the Exporting a Task and Importing a Task sections for 
more information about how to set up a computer one of these two ways.
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Exporting a Task
Complete the following steps to export a task to another computer.

1. Select a VI Logger task name in the MAX configuration tree. 

2. Click Export Task in the toolbar, or select Tools»VI Logger»Export 
Task, or right-click the VI Logger task and select Export Task. The 
Save As dialog box appears.

3. Enter a task name followed by a .xml file extension.

4. Choose a location on the computer where you want to save the task. 

5. Click Save. The .xml file is then saved to the specified location on the 
computer.

Refer to the Importing a Task and Creating a New Database sections for 
more information about accessing a device and its hardware configuration 
remotely from a destination computer. If the destination computer has an 
identical device and device hardware configuration setup as the source 
computer, continue to the following Importing a Task section. 

Importing a Task
Complete the following steps to import a task into VI Logger.

1. From the menu, select Tools»VI Logger»Import Task.

2. Select the task .xml file you exported earlier. If you are remotely 
accessing the device, select the .xml file from the source computer.

3. Click Open. 

The imported task appears in the VI Logger category with the other 
tasks.

Creating a New Database
The VI Logger database is where task runs are stored. Complete the 
following steps to create a new database.

1. Select Tools»VI Logger»Database. The Database dialog box 
appears. If this is the first time you are creating a database, the default 
database path should already be checked.

2. Click Create New. The Create Database dialog box appears.

3. Enter a descriptive name for the new database. 

4. Enter or browse to a file path for the database. 
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5. Click OK. The Database dialog box appears with the new name and 
path where data is being stored. 

6. If you want to store task runs in the new database, right-click the new 
database, and select Set as Default or double-click the database. 
A check mark appears to the left of the database name.

7. Click Close.

Once you have created a database, you can compact, delete, and rename the 
database.

Compact a Database
To save disk space, you can compact a database in VI Logger. Complete 
the following steps to compact a database.

1. Select Tools»VI Logger»Database. The Database dialog box 
appears.

2. Right-click a database and select Compact.

3. Click the Start button. A progress bar monitors the compacting 
operation.

4. Click the Close button.

Rename a Database
Complete the following steps to rename a database in VI Logger.

1. Select Tools»VI Logger»Database. The Database dialog box 
appears.

2. Right-click a database and select Rename.

3. Enter the new name for the database.

Delete a Database
Complete the following steps to delete a database.

1. Select Tools»VI Logger»Database. The Database dialog box 
appears.

2. Right-click a database and select Delete.

3. Click the OK button to the warning message that appears, asking if you 
are sure you want to delete the database.
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Publish Data to the Web
Use VI Logger to publish data on the Web. Click the Advanced task 
attributes button in the Task Attributes view and click the Publish to the 
Web tab. Select which channels to publish, the timespan of the data 
displayed, and how often to update the .htm file. You also can publish 
logged data to an FTP site. 

Note The VI_Logger_Web.html file must be in a folder named source in the same 
directory that you publish task data to for the data to be formatted correctly.

You also can store data on an FTP site using this dialog box by placing a 
checkmark in the Store HTML files on FTP checkbox, and entering the 
relevant information about the FTP site.



© National Instruments Corporation 6-1 Getting Started with VI Logger

6
Controlling a Task 
Programmatically 
Using LabVIEW

Although VI Logger is a stand-alone tool, you also can use LabVIEW to 
control tasks programmatically, which gives you greater control over 
executing tasks. This chapter explains background information about using 
the LabVIEW VI Logger VIs. Refer to the LabVIEW Help for more 
information about specific VIs. 

Before you start building a VI Logger application in LabVIEW, you should 
know some of the following basic concepts about VI Logger in the 
Measurement & Automation Explorer (MAX).

• Configuring a VI Logger task in MAX

• Running a VI Logger task in MAX

• Viewing data from a VI Logger task run in MAX

Refer to Chapter 2, Creating and Running a VI Logger Task, for more 
information about VI Logger tasks in MAX.

Executing a Task Using the VI Logger VIs
Use the VI Logger VIs located on the Functions»VI Logger palette to run 
your task. The VI Logger palette contains Easy, Intermediate, and 
Advanced VIs. Refer to the LabVIEW Help for more information about 
VI Logger VIs.

The following figure of the LabVIEW VI palette shows the location of the 
VI Logger VIs on the palette.
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Using Easy VI Logger VIs
Use the Easy VI Logger VIs to perform high-level VI Logger operations. 
With these VIs, you can begin executing a VI Logger task configured in 
MAX, read live data from the task while it is logging, wait for the task to 
finish, or manually stop a VI Logger task.

Using Intermediate VI Logger VIs
Use the VI Logger Status VI to obtain status information from the currently 
executing task. The status contains information about the state of the task, 
such as how many points have been logged and if a backlog exists. A 
growing backlog indicates a lack of CPU bandwidth to log the data. You 
can free CPU processor time by turning event detection off, not publishing 
data to DataSocket, or not reading all the logged data in LabVIEW. You 
can configure these options in MAX or programmatically using the 
Logger Set Output VI.

1 Easy VIs
2 Intermediate VIs

3 Advanced VIs
4 Data VIs

1

2

3

4
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Using Advanced VIs
Use the Advanced VI Logger VIs to gain more control of VI Logger tasks. 
Use the Advanced VIs to load a VI Logger task and have multiple start and 
stop sequences before unloading the task. You also can reset a specific task, 
which is useful if your previous execution aborted abnormally.

Executing a Task Using the VI Example Logger VIs
Refer to the Examples\VI Logger\Logging Examples.llb directory 
for common solutions using the VI Logger Reader VIs. These examples 
show you how to use the VI Logger Easy Reader VIs to view the logged 
data of a task named My Task1.

Reading Historic Data Using the VI Logger Data VIs
Use the VI Logger Data VIs located on the Functions»VI Logger»
VI Logger Data to read and analyze logged historic data.

Use the VI Logger Data VIs to open, read, get attributes, and close the tasks 
you created in MAX. The VI Logger Data palette contains Easy, 
Intermediate, and Advanced VIs.

Using the Easy VI Logger Reader Data VI
Use the Easy VI Logger Reader VI to perform simple read operations. You 
can run this VI from its front panel or use it as a subVI in basic reading 
applications. The Easy VI Logger Reader VI outputs polymorphic data as 
waveform data or a 2D scaled data array.

Note All data has time stamps, so you can view it with its time information.

Using the Intermediate VI Logger Reader VIs
Use the Intermediate VI Logger Data VIs to provide more functionality for 
complex historical data and analysis. From any logging task, you can view 
any run and access its attributes.

Using the Advanced VI Logger Reader VIs
Use the Advanced VI Logger Data VIs to provide additional functionality 
for complex historical data analysis, such as opening any logging task or 
access any runs or a selected attribute.
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A
Math Expression Editor 
Function Descriptions

This appendix describes the math expression editor functions in detail. 
Complete the following steps to access these functions for use in a 
calculated channel.

1. Click Add Channel from the from the Calculated Channels view. 
The Math Expression Editor dialog box appears. 

2. Select User Defined in the Formula field of the Formula Settings 
section. You can use these functions in formulas for a calculated 
channel.

Example

sin(Ch 1/Ch 2) + 3*tan(Ch 3)2-2

You can use the following operators:

+ and – for addition and subtraction

* and / for multiplication and division

** and ^ for exponentiation

Function Name Purpose

abs(x) Absolute Value Returns the absolute value of x

acos(x) Inverse Cosine Computes the inverse cosine of x in radians

acosh(x) Inverse Hyperbolic Cosine Computes the inverse hyperbolic cosine of x

asin(x) Inverse Sine Computes the inverse sine of x in radians

asinh(x) Inverse Hyperbolic Sine Computes the inverse hyperbolic sine of x

atan(x) Inverse Tangent Computes the inverse tangent of x in radians

atanh(x) Inverse Hyperbolic Tangent Computes the inverse hyperbolic tangent of x 
in degrees

ceil(x) Round to +Infinity Rounds x to the next higher integer (smallest 
integer is greater than or equal to x)
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cos(x) Cosine Computes the cosine of x in radians

cosh(x) Hyperbolic Cosine Computes the hyperbolic cosine of x in degrees 

cot(x) Cotangent Computes the cotangent of x in radians 
(1/tan(x))

csc(x) Cosecant Computes the cosecant of x in radians 
(1/sin(x))

exp(x) Exponential Computes the value of e raised to the x power 

expm1(x) Exponential (Arg – 1) Computes the value of e raised to the x power 
minus 1 (e^(x – 1))

floor(x) Round to –Infinity Truncates x to the next lower integer (largest 
integer is smaller than or equal to x)

getexp(x) Mantissa & Exponent Returns to exponent of x

getman(x) Mantissa & Exponent Returns to mantissa of x

int(x) Round to Nearest Round its argument to the nearest integer

intrz(x) Round Toward 0 Rounds x to the nearest integer between 
x and 0

ln(x) Natural Logarithm Computes the natural logarithm of x (to the 
base of e)

lnp1(x) Natural Logarithm 
(Arg + 1)

Computes the natural logarithm of (x + 1)

log(x) Logarithm Base 10 Computes the logarithm of x (to the base of 10)

log2(x) Logarithm Base 2 Computes the logarithm of x (to the base of 2)

pow(x, y) x^y Computes the value of x raised to the y power 

rand( ) Random Number (0–1) Produces a floating-point number between 
0 and 1 exclusively

sec(x) Secant Computes the secant of x, where x is in radians 
(1/cos(x))

sign(x) Sign Returns 1 if x is greater than 0, returns 0 if x is 
equal to 0, and returns –1 if x is less than 0

sin(x) Sine Computes the sine of x, where x is in radians

Function Name Purpose
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sinc(x) Sinc Computes the sine of x divided by x radians 
(sin(x)/x)

sinh(x) Hyperbolic Sine Computes the hyperbolic sine of x in degrees

Sqrt(x) Square Root Computes the square root of x

tan(x) Tangent Computes the tangent of x in radians

tanh(x) Hyperbolic Tangent Computes the hyperbolic tangent of x in 
degrees

pi(1), pi(2) pi, 2pi —

Function Name Purpose
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B
Setting Up an Event Email

This appendix describes how to set up an event email using the Event 
Action feature in VI Logger. The event email is sent when an event starts 
and when it stops. VI Logger uses the SMTP Send Message VI from the 
LabVIEW Internet toolkit to generate the email.

Complete the following steps to set up an email event action.

1. In the Virtual Channels, FieldPoint Channels, or Calculated 
Channels view, in the Active Channel field, right-click a channel 
name for which you want to set an event.

2. Select Events to open the Event properties for dialog box.

3. In the Event properties dialog box, in the Action Type field, select 
Send Email Message. 

4. In the Mail Server field, enter the SMTP server to send the message 
through.

5. In the Message field, enter a custom message to include in the email. 
Your custom message appears first, and then the default message is 
appended to your custom message.

6. In the To field, enter a list of email addresses to which to send the event 
message.

7. Click OK.

This is what an example email message may look like:

From: VI Logger

To: John Smith@ni.com

Subject: "My Temperature Channel 1" has exceeded its 

event limit.

testing

Thursday, March 15, 2001

8:34:29 AM

DAQ Channel: "My Temperature Channel 1"

Current value: 51.000000 C

Event Type: High

High Limit: 50.000000 C
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Values of all Channels:

My Temperature Channel 1: 51.000000 C

The appropriate values and strings that are entered into the email message 
are shown:

{Custom message here}

{Day of week, Month, Date, 4-digit year}

{HH:MM:SS AM/PM}

DAQ Channel: "{Channel Name}"

Current value: {Current Value} {Channel Units}

Event Type: {Event Type}

High Limit: {High Limit} {Channel Units} 

Low Limit: {Low Limit} {Channel Units}

Values of all Channels:

{First Channel Name}: {First Channel Value} {First 

Channel Units}

{Second Channel Name}: {Second Channel Value} {Second 

Channel Units}

...

{Last Channel Name}: {Last Channel Value} {Last Channel 

Units}
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Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit our extensive library of technical support resources available 
in English, Japanese, and Spanish at ni.com/support. These 
resources are available for most products at no cost to registered 
users and include software drivers and updates, a KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, 
conformity documentation, example code, tutorials and 
application notes, instrument drivers, discussion forums, 
a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 
measurement and automation professionals by visiting 
ni.com/support. Our online system helps you define your 
question and connects you to the experts by phone, discussion 
forum, or email.

• Training—Visit ni.com/training for self-paced tutorials, videos, 
and interactive CDs. You also can register for instructor-led, hands-on 
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, NI Alliance Program 
members can help. To learn more, call your local NI office or visit 
ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

C

channel Pathway from a CPU or, on a network, between computers. 

A channel also can be an input connection to a data acquisition system or 
to an instrument, such as an oscilloscope or logic analyzer. 

Pin or wire lead to which you apply or from which you read an analog or 
digital signal. Analog signals can be single-ended or differential. For digital 
signals, channels group to form ports. Ports usually consist of either four or 
eight digital channels. 

CPU Central processing unit. The computational and control unit of a computer 
that interprets and executes instructions. CPU also can refer to the case that 
holds the components of your computer, excluding the monitor and 
keyboard.

D

DAQ See data acquisition.

data acquisition DAQ. Process of acquiring data, typically from A/D or digital input plug-in 
devices.

DataSocket A standardized software interface technology that provides automation 
data description headers as part of the data transfer protocol.

dB Decibel. The unit for expressing a logarithmic measure of the ratio of two 
signal levels: dB=20log10 V1/V2, for signals in volts. Refer to the NI 
Developer Zone Glossary at ni.com/zone, for a more detailed 
explanation.

dBV dB relative to 1 V.
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F

FieldPoint item One or more channels or variables in a FieldPoint bank that can be 
monitored or controlled by the Measurement & Automation Explorer 
(MAX). In MAX, items are normally I/O points. A blue icon indicates that 
the item is being monitored. A gray icon indicates that the item is not being 
monitored.

H

HTML Hypertext markup language. An ASCII text-based, script-like language for 
creating hypertext documents like those on the Web.

I

IP Internet Protocol. A layer of three networking protocols used by routers for 
connectionless data communications.

L

LED Light-emitting diode.

M

MAX Measurement & Automation Explorer. See also Measurement & 
Automation Explorer.

Measurement & 
Automation Explorer

The standard National Instruments hardware configuration and diagnostic 
environment for Windows.

N

noise An undesirable electrical signal—noise comes from external sources such 
as the AC power line, motors, generators, transformers, fluorescent lights, 
soldering irons, CRT displays, computers, electrical storms, welders, radio 
transmitters, and internal sources such as semiconductors, resistors, and 
capacitors. Noise corrupts signals you are trying to send or receive.
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P

Plug and Play devices Devices that do not require DIP switches or jumpers to configure resources 
on the devices. Also called switchless devices.

S

scan rate The number of scans per second. For example, a scan rate of 10 Hz means 
sampling each channel 10 times per second.

SMTP Simple mail transfer protocol.

T

trigger Any event that causes or starts some form of data capture.

U

URL Uniform resource locator. A logical address that identifies a resource on the 
Internet. For example, the URL http://www.ni.com, is the Internet 
address for the National Instruments home page.

V

VI See virtual instrument (VI).

virtual instrument (VI) Program in LabVIEW that models the appearance and function of a 
physical instrument.

X

XML Extended markup language.
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